What's in a Name: Uncover the Meaning behind Windows Files and Processes

Larisa Long
Task Manager Forensics

GIAC GCFA Gold Certification

Author: Larisa April Long, lapril@dc.rr.com
Advisor: Egan Hadsell

Abstract
Have you ever opened Task Manager and been mystified by a bizarrely named Windows process such as toaster, fuel service or seaport? Whether pursuing a forensic investigation or troubleshooting, Task Manager is the perfect tool to display information about Windows files. There are several alternatives to Task Manager, but few computer users take advantage of the simple yet powerful tool already installed on every Windows OS.
1. Introduction

When a system has been compromised, forensic analysts have to be part researcher and part investigator. They must be able to parse out known or healthy files to eliminate them as possible clues. Like the old saying goes: know what you don’t know, but know where to find the answers.

There are several definitions of a digital forensic investigation. Brian Carrier describes a digital investigation “where we develop and test hypotheses that answer questions about digital events” (Carrier, 2005). He believes the inclusion of the word forensic automatically implies a court of law (Carrier, 2005). Whether or not a court of law will be the ultimate goal, volatile evidence is crucial in any digital investigation. “Evidence is the core of what an investigator is going to seek. Evidence is anything that can be used to prove or disprove a fact” (Lee, 2010).

There are two main investigations in forensic analysis: live and dead. “Dead” forensics or traditional forensics entails examining powered down systems, creating bit copies of hard drives, constructing timelines and performing file system analysis. This traditional forensic path is the most common forensics investigation used for criminal cases that must be proven in court.

A live investigation is “often used in incident handling to determine if an event has occurred” and “may or may not proceed a full traditional forensic analysis” (McDougal, 2006). An investigation might have to be attempted on a live, or active, machine if it cannot be disconnected or powered down due to business or production purposes. There are also problems with active machines: “the process of proving a live image that’s forensically sound and unaltered is more complex than with dead system images. Running systems write to memory many times each second” (Vacca & Rudolph, 2011).
Volatile evidence, or evidence that will be lost when the computer is powered down, is essential to every investigation. Evidence in memory, network connections and running processes are the most volatile of evidence and must be collected first (Lee, 2010).

“An investigator will always want to know what processes are running on a potentially compromised system. Note the word always” (Carvey, 2009). Turn on a Windows computer, and dozens of processes are automatically opened. Many of the programs are core files needed to operate the OS, and some are user initiated. A list of open processes will help create a timeline of events by detailing what programs were open prior to, during and after an incident.

There are plenty of forensic tools included in Helix that will gather a list of running processes, but a quick and dirty solution is the Task Manager. It is already installed on every Windows computer and experts and novices alike can use Task Manager to get a quick snapshot of potential problems.

“In the early days of Windows, the Task Manager was more important than it is now. That’s because those early versions of Windows lacked a Taskbar” (Gookin, 2007). Early versions of Task Manager, like the image shown below in a computer running Windows 3.0, were necessary to list programs and choose between them (Sinofsky, 2011).

Larisa April Long, lapril@dc.rr.com
Windows 7 Task Manager obviously provides more information than just a way to switch between programs. Even with advances, however, Task Manager tends to denigrated by advanced computer users who opt for installing replacement software. Process Hacker, Anvir Task Manager, Process Explorer, System Explorer, or What’s Running 3.0. are some of the examples of Task Manager alternatives (Williams, 2010; Lifehacker, 2009).

Even though Windows 7 Task Manager has evolved, Microsoft found that up to 85% used only the Applications and Processes Tabs (Sinofsky, 2011). This, in essence, means Task Manager’s sole purpose is closing an unresponsive program (Albanesius, 2011; Paul, 2011).

2. Task Manager

How do you open Task Manager? Like the majority of computer tasks, there are many different ways to achieve the same result:

Larisa April Long, lapril@dc.rr.com
2.1 Task Manager Deconstructed

Once Task Manager is opened, there are six tabs.

The first tab, **Applications**, will list the name of each task plus their status, and the second tab, **Processes**, will list open processes. Right clicking on any process will provide choices such as ending a process, opening the specific file location or checking on properties. The properties option provides information such as the name, type, location and description of a file as well as the date when the file was created, modified and accessed.

Larisa April Long, lapril@dc.rr.com
The third tab, **Services**, details the names of the services as well as the Process Identifier (PID), description, status and group. “A service is a specialized program that performs a function to support other programs” (Bott, Siechert, & Stinson, 2007). Right clicking on any service will allow users to start, stop or go to process, and clicking the Services button will open the Microsoft Management Console (MMC).

The Processes and Services tab can be used together to link running processes with the particular service they are using. While in the Processes tab, right clicking on any process will open a dialog box that will allow users to ‘Go to Service.’ In the Services tab, right clicking on a service will open a choice to ‘Go to Process.’ Doing this allows users to determine which process opens up which service and vice versa.

Each field in the Services and Processes tab can be sorted, and sorting the PID in both can provide a good view as to what process is using which services.

Larisa April Long, lapril@dc.rr.com
The forth tab, Performance, provides a quick snapshot as to the relationship between RAM and processes:

Total indicates the amount of system RAM, and Cached lists the RAM recently used. “This memory will remain in the cache in case the system resources are needed again, but it’s available should other operations need it” (Shultz, 2010). The RAM not being used (Available) is listed as well as how much RAM is being cached that does not hold necessary information (Free).

The number of Processes are listed as well as Handles and Threads. The amount of time from the last computer restart (Up Time) and the usage of Page files – both the amount being used and the amount available for use (Commit) – give a clear picture of memory usage. “The page file is used by Windows to hold temporary data which is swapped in and out of physical memory in order to provide a larger virtual memory set” (Hameed, 2007).

For an even more in-depth view of the relationship between memory and open processes, clicking on the Resource Monitor button will monitor “resource usage in real time” (Microsoft, 2009).

Once in the Resource Monitor, there are tabs that will give a more visual representation of TCP connections and listening ports. It will show the processes that have network or disk activity, handles and modules. “Handles are pointers that refer to system elements including (but not limited to) files, registry keys, events, or directories. Modules are helper files or programs

Larisa April Long, lapril@dc.rr.com
including (but not limited to) dynamic-link library (DLL) files” (Microsoft, 2011d). Below, is a graphic of the physical memory in Resource Monitor:

![Physical Memory](image)

The fifth tab, **Networking**, displays active network connections and a graphical representation of the number of bytes sent and received. Suspicious activity can be seen in high bandwidth or usage on a network adapter that should not be currently in use.

Finally, the sixth tab, **Users**, will provide information about the name and number of users logged on. At the bottom of the screen, there are buttons for disconnecting, logging off and sending another user a message.

### 2.1.1 Task Manager Columns In Processes Tab

It is important to use Task Manager to the fullest. The information under the Applications, Services and Performance tabs cannot be changed, but different columns can be added to expand the information available in the Processes, Networking and Users tabs. While in the Processes Tab, clicking on the View menu and clicking on Select Columns can expand the information available for each process.

![Task Manager Columns](image)

Larisa April Long, lapril@dc.rr.com
Thirty different columns can be chosen (Microsoft, 2011b).

**PID (Process Identifier):** the number that identifies a process. “The operating system accesses all processes by their numbers, not their names” (Boyce, 2009).

**User Name:** the user account the process is running under

**Session ID:** the number that identifies the user. Each user will have their own ID if there are multiple users logged on. According Jim Boyce, the number will be zero unless Terminal Services are used (Boyce, 2009).

**CPU Usage:** the % of CPU that a process is using

While the CPU usage time is normally a good indicator of what percentage of a processor is being used, there is an exception. The system idle process should have an extremely high number. Normally, a high number in CPU usage would indicate how much of the CPU is being used for the process. A high number in System Idle Process indicates how much of the CPU is actually available. For instance, if the System Idle Process is at 99. That means 99% of the CPU is available. “The computer should perform better when the System Idle process has a higher percentage, because the System Idle process stores remaining resources. Lower amounts means the system is being taxed at a greater rate” (Mikael, 2011).

**CPU Time:** time used by process (measured in seconds)

**Memory – Working Set:** the amount of memory the process is using

Larisa April Long, lapril@dc.rr.com
Memory – Peak Working Set: largest amount of memory the process has used
Memory – Working Set Delta: amount of change in the working set memory
Memory – Private Working Set: amount of memory a process is using that cannot be shared
Memory – Commit Size: amount of virtual memory a process has reserved
Memory – Paged Pool: amount of virtual memory that can be written to another medium (like a hard disk) for storage
Memory – Non-Paged Pool: amount of virtual memory that cannot be written to another medium
Page Faults: number of times data has to be disk retrieved because it was not in memory
Page Fault Data: change in number of page faults since the last update
Base Priority: a ranking of the order the process threads are scheduled
Handles: number of object handles
Threads: number of threads in process
USER Objects: number of user objects being used. “A USER object is an object from Window Manager, which includes windows, menus, cursors, icons, hooks, accelerators, monitors, keyboard layouts, and other internal objects” (Microsoft, 2011e).
GDI Objects: the number of objects from the GDI (Graphics Device Interface) library
I/O Reads: the number of read input/output operations ordered by process
I/O Writes: the number of write input/output operations ordered by process
I/O Other: the number of input/output operations that are not read or write
I/O Read Bytes: number of bytes read in input/output operations
I/O Write Bytes: number of bytes written in input/output operations
I/O Other Bytes: number of bytes transferred in input/output operations that are not read or write
Image Path Name: the exact directory where file is located
Command Line: the command used to launch the process
User Account Control (UAC) Virtualization: identifies if UAC is used, disabled or not allowed for process
Description: will list, usually brief, an explanation of the process
Data Execution Prevention: identifies whether data execution prevention, a Windows security feature that tries to prevent data from being executed, is enabled or disabled.

At the very least, CPU Usage, Image Path Name, Command Line and the Description fields should be checked. Memory – Working Set and Memory – Peak Working Set can be checked in order to compare any difference between the memory the process is currently using versus the most it has ever used. A vast difference between past and present usage amounts could help with a timeline.

Larisa April Long, lapril@dc.rr.com
Once the columns are chosen, use the double arrow resize cursor to increase the size of the final columns to ensure the entire information field can be seen. The column width can go from this:

![Column size comparison image]

…to this:

![Column size comparison image]

Also, in the View Menu, there is an option for setting the speed at which Task Manager updates.

High refreshes Task Manager twice each second. Normal updates every two seconds. Low updates every four seconds, and paused will not allow Task Manager to update automatically (Boyce, 2009). Like the Refresh Now option, hitting F5 will update in Paused mode.

### 2.1.2 Task Manager Columns in Networking Tab

While in the Networking Tab, clicking on the View menu and clicking on Select Columns can expand the information available.
The twenty-five columns (Microsoft, 2011c) are described below:

- **Adapter Description**: Description of adapter; usually same name as given to device in network connections folder
- **Network Utilization**: initial connection speed percentage of network utilization
- **Link Speed**: initial speed of connection
- **State**: the network connection would be connected or disconnected
- **Bytes Sent Throughput**: connection bandwidth used (in percentage) by traffic sent
- **Bytes Received Throughput**: connection bandwidth used (in percentage) by traffic received
- **Bytes Throughput**: connection bandwidth percentage used by both sending and receiving traffic
- **Bytes Sent**: total bytes sent
- **BytesReceived**: total bytes received
- **Bytes**: combination of sent and received bytes
- **Bytes Sent Per Interval**: total number of bytes sent in interval
- **Bytes Received Per Interval**: total number of bytes received in interval
- **Bytes Per Interval**: total number of sending and receiving bytes
- **Unicasts Sent**: number of bytes requested to unicast addresses (will include packets that were not sent or otherwise discarded) “Unicast is a one-to one connection between the client and the server. Unicast uses IP delivery methods such as Transmission Control Protocol (TCP) and User Datagram Protocol (UDP), which are session-based protocols” (Microsoft, 2003).
- **Unicasts Received**: number of bytes received from unicast addresses
- **Unicasts**: total number of sending and receiving bytes

Larisa April Long, lapril@dc.rr.com
Unicasts Sent Per Interval: total number of bytes sent to subnet unicast addresses
Unicasts Received Per Interval: total number of bytes received from subnet unicast addresses
Unicasts Per Interval: total number of sending and receiving unicast packets
Nonunicasts Sent: total number of bytes sent to nonsubnet unicast addresses
Nonunicasts Received: total number of bytes received from non subnet unicast addresses
Nonunicasts: total number of sending and receiving non unicast packets
Nonunicasts Sent Per Interval: total number of bytes sent to non subnet unicast addresses
Nonunicasts Received Per Interval: total number of bytes received from non subnet unicast addresses
Nonunicasts Per Interval: total number of sending and receiving non unicast packets

Clicking on network utilization, link speed, state as well as bytes sent, bytes received and bytes can provide a good explanation to how the network is processing information. Clicking on each of the columns can help create a timeline of network events as the Options menu can be reset or show cumulative data to get a better view of what happened previously.

2.1.3 Task Manager Columns in User’s Tab

User Name: the name of the user logged onto system
ID: the numeric ID identifier
Status: the status of the connection; active or disconnected
Client Name: name of the client computer; sometimes left blank if not applicable
Session: session name of computer

2.2 Down and Dirty with Windows Directories

When a process is opened either by a user or by the computer, it will be listed in the Task Manager, and the original file can be located in one of the core windows directories.
Windows files are confusing. There’s no other way around it. It takes tens of thousands of files for Windows to run properly, and that’s only counting core files and not user initiated software installations.

2.2.1. Core directories of C:\Program Files, C:\Program Files(x86) and C:\ProgramData

Many forensic types love Linux based systems because of their user friendly simplicity, and most forensic tools are Linux based. However, the majority of computer users still use Windows OS: it is essential to understand core Windows directories.

C:\Program Files is a folder that keeps 64 bit program files. 32 bit and 64 bit refers to how the computer’s processor manages information. Processes that can manage 64 bits means they have access to more RAM and process information much faster than a 32 bit computer (Microsoft, 2011a).

C:\Program Files (x86) is a folder for 32 bit program files compatible with older x86 processors. The (x86) of the C:\Program Files (x86) refers to the name of a 32 bit process architecture whose other process names include 8086 and 80186.

In other words, all 64-bit applications must be installed in the c:\Program Files directory, and all 32-bit applications must be installed in the c:\Program Files (x86) directory.

The C:\ProgramData folder holds application data, including user and program settings, for installed processes.

2.2.2. C:\Windows directories of system, System32 and SysWOW64

Larisa April Long, lapril@dc.rr.com
C:\windows\system includes backward compatibility files. Windows likes to make things more interesting by having core OS files for 64 bit systems inside the System 32 directory and 32 bit files included under the c:\Windows\sysWOW64 directory.

WOW64 means windows on windows 64 bit which allows 32 bit applications to run in 64 bit OS. According to Microsoft, WOW64 provides Windows 32-bit On Windows 64-bit by using a layer that allows 32 bit applications to run on the more advanced 64 bit OS. “At a high level, WOW64 is a collection of user-mode DLLs that intercepts calls to and from 32-bit processes and translates them” (Microsoft, 2010).

3. What’s In a Name?

“Many investigators and even system administrators are not familiar enough with Windows systems to recognize default or ‘normal’ processes at a glance” (Carvey, 2009). This is where knowledge of core Windows files is a necessity.

Computer professionals have borrowed their fair share of originally non-computer terms like virus, worm, and Trojan to describe the nastiest bytes. What does etymology have to do with it? Even though windows files can be confusing, there are clues.

<table>
<thead>
<tr>
<th>within name</th>
<th>Most Likely Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>ati</td>
<td>most likely – ATI technologies dealing with ATI Radeon family of video graphics; also likely: advanced micro devices (AMD) desktop component</td>
<td>atieclxx.exe atiesrxx.exe</td>
</tr>
<tr>
<td>bing</td>
<td>Microsoft Bing Bar related</td>
<td>bingapp.exe bingbar.exe</td>
</tr>
<tr>
<td>cn</td>
<td>Canon printer related</td>
<td>CNMSUT.exe</td>
</tr>
<tr>
<td>explore</td>
<td>Microsoft Windows application</td>
<td>explorer.exe</td>
</tr>
</tbody>
</table>

Larisa April Long, lapril@dc.rr.com
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Process Name(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>firefox</td>
<td>Mozilla Firefox Browser</td>
<td>iexplore.exe, firefox.exe</td>
</tr>
<tr>
<td>host</td>
<td>provides a host function</td>
<td>WUDFHost.exe, taskhost.exe, svchost.exe</td>
</tr>
<tr>
<td>mc</td>
<td>McAfee</td>
<td>mcsacore.exe</td>
</tr>
<tr>
<td>msi</td>
<td>Microsoft installer (MSI) package files</td>
<td>msiexec.exe</td>
</tr>
<tr>
<td>ra</td>
<td>Realtek Audio</td>
<td>RAVCpl64.exe</td>
</tr>
<tr>
<td>rundll</td>
<td>runs dynamic link library (dll) files</td>
<td>rundll.exe</td>
</tr>
<tr>
<td>search</td>
<td>Search function</td>
<td>SearchIndexer.exe, searchprotocolhost.exe</td>
</tr>
<tr>
<td>services</td>
<td>Services function</td>
<td>services.exe, SftService.exe</td>
</tr>
<tr>
<td>shwicon</td>
<td>show icon</td>
<td>shwiconXP9106.exe</td>
</tr>
<tr>
<td>spl</td>
<td>spooler, spool</td>
<td>spoolsv.exe, splwow64.exe</td>
</tr>
<tr>
<td>spool</td>
<td>service</td>
<td>vssvc.exe, armsvc.exe, ccSvcHst.exe, svchost.exe, FusionSVC.exe</td>
</tr>
<tr>
<td>svc</td>
<td>service</td>
<td>System, System Idle Process</td>
</tr>
<tr>
<td>system</td>
<td>system core file</td>
<td>taskeng.exe, taskhost.exe, taskmgr.exe</td>
</tr>
<tr>
<td>task</td>
<td>task</td>
<td>dpupdchk.exe, jusched.exe</td>
</tr>
<tr>
<td>updchk</td>
<td>update check</td>
<td>vmnat.exe, VMware-authd.exe, vmware-usarbitrator.exe, vmnetdhcp.exe</td>
</tr>
<tr>
<td>usched</td>
<td>update schedule</td>
<td>wininit.exe, winlogon.exe, winmsgballoon, WINWORD.EXE</td>
</tr>
<tr>
<td>vm</td>
<td>VMWare</td>
<td>wmpnetwk.exe</td>
</tr>
<tr>
<td>win</td>
<td>windows</td>
<td>Larisa April Long, <a href="mailto:lapril@dc.rr.com">lapril@dc.rr.com</a></td>
</tr>
<tr>
<td>wmp</td>
<td>windows media player</td>
<td></td>
</tr>
</tbody>
</table>
3.1 Acronyms

<table>
<thead>
<tr>
<th>Acronyms</th>
<th>Descriptions</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>ccc</td>
<td>Catalyst Control Centre</td>
<td>CCC.exe</td>
</tr>
<tr>
<td>csrss</td>
<td>Microsoft Client Server Runtime Server Subsystem</td>
<td>csrss.exe</td>
</tr>
<tr>
<td>dwm</td>
<td>Desktop Windows Manager</td>
<td>dwm.exe</td>
</tr>
<tr>
<td>lsass</td>
<td>Local Security Authority Process</td>
<td>lsass.exe</td>
</tr>
<tr>
<td>lsm</td>
<td>Local Session Manager</td>
<td>lsm.exe</td>
</tr>
<tr>
<td>smss</td>
<td>Session Manager Subsystem</td>
<td>smss.exe</td>
</tr>
<tr>
<td>wmi</td>
<td>Windows Management Instrumentation</td>
<td>WmiPrvSe.exe</td>
</tr>
</tbody>
</table>

3.1.1 Reveal Nothing

Some files prefer to use names that give nothing away. Seaport and fuel service do not indicate anything of what they are unless they have something to do with a fueling depot at an airport. Runkbot sounds like the latest run amok robot. Files with names like q, b, xad and racoom could be spy names. The bizarrely named files are actually (System Explorer, 2011):

<table>
<thead>
<tr>
<th>file name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>b.exe</td>
<td>Boxer software text editor</td>
</tr>
<tr>
<td>fuel.service.exe</td>
<td>part of AMD/ATI graphics cards</td>
</tr>
<tr>
<td>q.exe</td>
<td>System Internals rootkit revealer</td>
</tr>
<tr>
<td>racoom</td>
<td>Raccoom company tree view folder browser</td>
</tr>
<tr>
<td>runkbot.exe</td>
<td>Dell executable</td>
</tr>
<tr>
<td>seaport.exe</td>
<td>Microsoft windows live seaport search enhancement pack; used when performing searches</td>
</tr>
<tr>
<td>Toaster.exe</td>
<td>Dell DataSafe Local Backup; SoftThinks</td>
</tr>
<tr>
<td>xad.exe</td>
<td>Microsoft console based script host</td>
</tr>
</tbody>
</table>

3.2 Multiple Instances & (*32) after Process Name

There are several files that will open multiple times in Task Manager such as conhost.exe, csrss.exe, rundll.exe and svchost.exe. Most of the multiple instances files will be located in the windows\system32 or windows\sysWOW64 directories (Geek, What is conhost.exe and Why Is It Running?, 2009). Usually, the multiple instances are harmless.
because each one is performing a different task. Since malware can be hidden in processes, it is important to be aware of each purpose.

Sometimes processes appear with *32 after the process name. This just means it’s a 32-bit process running on a 64-bit OS.

4. Task Manager’s Drawback: Suspect Everything

When forensic analysts need to quickly verify that an incident has taken place and acquire evidence, tediously parsing through unknown windows files can slow down an investigation. Several questions can arise: How do you know what is legitimate and what isn’t supposed to be there? Is there a way to determine from the file name itself what the file is?

Use Task Manager to get the basics of running processes. If you can’t open a process or file locations by right clicking in Windows Task Manager, be sure to click ‘show processes from all users’.

If there is a question about a process, it is important to locate the file and research whether the file is legitimate or not. The main drawback to Task Manager: “When a program is running, there is no way in the Task Manager to really distinguish it from the legitimate version…” (Carvey, 2009).

While Task Manager will list the detailed information, how can you tell if a file has been corrupted by malware? Suspect “any file which uses system filename and is not stored in system directory or has invalid file version information. Correct system file contains full file version information from Microsoft” (System Explorer, 2011).

The first step is to use Task Manager to determine what can be learned initially such as complete file name, location and size of file. Next, research the file itself. Some may just use a search engine, like Google, to research a file name, but it is important to verify with reputable sources. Anyone can look up confusing file names with specialized websites like:

http://www.processlibrary.com

Larisa April Long, lapril@dc.rr.com
If a file is still suspected, check the hash files of the suspected file with the original. Download an MD5 or SHA program or use forensic tools such as Helix or Knoppix to compare checksums to good known hash values. Check hash files with sources such as System Explorer at http://systemexplorer.net/filedb.php, the Internet Storm Center at http://isc.sans.edu/tools/hashsearch.html or download them directly from the National Software Reference Library (NSRL) at http://www.nsrl.nist.gov/. Make sure the correct file and product version match the correct hash.

5. The Future of Windows Task Manager

In Windows 8, Microsoft has promised to improve on Task Manager (Paul, 2011) by automatically grouping processes according to user, windows and background. Also, it promises to decrypt windows names into more user friendly versions. Until Windows 8 becomes mainstream, there is a need to understand the conventional terms and names Microsoft uses in pre-Windows 8 computers.

6. Conclusion

Larisa April Long, lapril@dc.rr.com
Knowing the baseline of a computer is ideal before a suspected incident but not always possible. Whether troubleshooting a suspected process or pursuing a complex digital forensic investigation, understanding the basics of core windows files and directories is essential. When in doubt of the validity of a file, use Task Manager to locate file specifics. Employ knowledge of the etymology of file names to narrow down the meaning of the file. Research unknown files, and validate the file by comparing hash values with reputable sources. By knowing a little more about the core windows processes and where they are located, users can determine why a process is open in Task Manager and troubleshoot.
Forensic analysts must take advantage of every tool at their disposal, and Task Manager’s many uses go far beyond simply ending a process. Obviously Task Manager isn’t the only tool in a digital investigation, but it can be the first line of defense and provides a good foundation for further analysis.

If the investigation includes a forensic examination of a live system, performing basic troubleshooting, or wanting to know more about the files running on a computer, Task Manager is one of the simplest programs to use that doesn’t require an installation of another software program.

7. References


Larisa April Long, lapril@dc.rr.com


Larisa April Long, lapril@dc.rr.com


Larisa April Long, lapril@dc.rr.com
### Upcoming SANS Training

Click here to view a list of all SANS Courses

<table>
<thead>
<tr>
<th>Course</th>
<th>Location</th>
<th>Dates</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SANS Melbourne 2019</strong></td>
<td>Melbourne, AU</td>
<td>Aug 05, 2019 - Aug 10, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Minneapolis 2019</strong></td>
<td>Minneapolis, MNUS</td>
<td>Aug 12, 2019 - Aug 17, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>Supply Chain Cybersecurity Summit &amp; Training 2019</strong></td>
<td>Arlington, VAUS</td>
<td>Aug 12, 2019 - Aug 19, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS San Jose 2019</strong></td>
<td>San Jose, CAUS</td>
<td>Aug 12, 2019 - Aug 17, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Prague August 2019</strong></td>
<td>Prague, CZ</td>
<td>Aug 12, 2019 - Aug 17, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Chicago 2019</strong></td>
<td>Chicago, ILUS</td>
<td>Aug 19, 2019 - Aug 24, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Virginia Beach 2019</strong></td>
<td>Virginia Beach, VAUS</td>
<td>Aug 19, 2019 - Aug 30, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Amsterdam August 2019</strong></td>
<td>Amsterdam, NL</td>
<td>Aug 19, 2019 - Aug 24, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Tampa-Clearwater 2019</strong></td>
<td>Clearwater, FLUS</td>
<td>Aug 25, 2019 - Aug 30, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Copenhagen August 2019</strong></td>
<td>Copenhagen, DK</td>
<td>Aug 26, 2019 - Aug 31, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Hyderabad 2019</strong></td>
<td>Hyderabad, IN</td>
<td>Aug 26, 2019 - Aug 31, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Munich September 2019</strong></td>
<td>Munich, DE</td>
<td>Sep 02, 2019 - Sep 07, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Brussels September 2019</strong></td>
<td>Brussels, BE</td>
<td>Sep 02, 2019 - Sep 07, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Philippines 2019</strong></td>
<td>Manila, PH</td>
<td>Sep 02, 2019 - Sep 07, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Canberra Spring 2019</strong></td>
<td>Canberra, AU</td>
<td>Sep 02, 2019 - Sep 21, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Network Security 2019</strong></td>
<td>Las Vegas, NVUS</td>
<td>Sep 09, 2019 - Sep 16, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Oslo September 2019</strong></td>
<td>Oslo, NO</td>
<td>Sep 09, 2019 - Sep 14, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Dubai September 2019</strong></td>
<td>Dubai, AE</td>
<td>Sep 14, 2019 - Sep 19, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Raleigh 2019</strong></td>
<td>Raleigh, NCUS</td>
<td>Sep 16, 2019 - Sep 21, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>Oil &amp; Gas Cybersecurity Summit &amp; Training 2019</strong></td>
<td>Houston, TXUS</td>
<td>Sep 16, 2019 - Sep 22, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Rome September 2019</strong></td>
<td>Rome, IT</td>
<td>Sep 16, 2019 - Sep 21, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Paris September 2019</strong></td>
<td>Paris, FR</td>
<td>Sep 16, 2019 - Sep 21, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Bahrain September 2019</strong></td>
<td>Manama, BH</td>
<td>Sep 21, 2019 - Sep 26, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS San Francisco Fall 2019</strong></td>
<td>San Francisco, CAUS</td>
<td>Sep 23, 2019 - Sep 28, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Dallas Fall 2019</strong></td>
<td>Dallas, TXUS</td>
<td>Sep 23, 2019 - Sep 28, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS London September 2019</strong></td>
<td>London, GB</td>
<td>Sep 23, 2019 - Sep 28, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Kuwait September 2019</strong></td>
<td>Salmiya, KW</td>
<td>Sep 28, 2019 - Oct 03, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS Northern VA Fall- Reston 2019</strong></td>
<td>Reston, VAUS</td>
<td>Sep 30, 2019 - Oct 05, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>Security Awareness Summit &amp; Training 2019</strong></td>
<td>OnlineCAUS</td>
<td>Aug 05, 2019 - Aug 14, 2019</td>
<td>Live Event</td>
</tr>
<tr>
<td><strong>SANS OnDemand</strong></td>
<td>Books &amp; MP3s OnlyUS</td>
<td>Anytime</td>
<td>Self Paced</td>
</tr>
</tbody>
</table>